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makes more sense to go where the wave wants to take you,
as opposed to picking an arbitrary direction and hoping
the wave accommodates your plan. Similarly, you may not
want some potential patients to prefer clear plastic aligner
treatment, but that’s the direction it’s going regardless.
One can “ride the wave” by participating in this new
treatment modality, or steer off in an independent direction
and await the long-term consequences.
A similar situation applies to our decision to create Edge Specialist, an upcoming
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Inside Ortho2

someone said, “Hey, why don’t we try to sell to pediatric dentists?” We are Ortho2.
Orthodontics is and remains our primary focus. And we are riding the wave of
mobility and app-based features. We have recently completed Edge Pop and Edge
Signature, and will be releasing exciting new mobile applications for orthodontists
next year. But when the wave points to a future where orthodontics and pediatrics
are converging, then we also serve the orthodontic market by providing pediatric
features to those for whom it makes sense.

SMART Goals

by Andrea Cook

solution for cross-discipline practices. It isn’t that we had a meeting where

We understand that many of you don’t currently anticipate a need for pediatric
features. I believe that for some, this will change as circumstances move you closer
to the natural pediatric connection. But even if it doesn’t, you can take comfort
in the knowledge that, (a) you won’t have to purchase the pediatric module, (b)

10 –14

you may benefit from some cross-discipline features that you will receive as Edge
enhancements, and (c) you will benefit by having us here for you in the future as the

Comprehensive Orthodontic
Practice Management, Imaging, and
Communication Solutions

result of us remaining competitively strong as the orthodontic market continues to
evolve.
We don’t create the wave, but we sure intend to ride it to its full potential!

Dan Sargent, Ortho2 President

Ortho2 Webinar
Update
Beginning in 2018, you will see a change with the Ortho2 monthly webinars. Instead of a specific date
and time, each webinar will be available on demand. Each month will present on a topic specific to Edge

Be Social this UGM!
Be sure to follow Ortho2 on Facebook
for additional and fun information leading
up to the UGM. We’ll have live videos
featuring frequently asked questions, party
info, and how to get active with Ortho2 on
social media while you’re in Savannah.

or ViewPoint, and the webinar will be available for the entire month.
Simply go to www.ortho2.com > Meetings and Webinars > Ortho2 Webinars to find the link for the current
month’s webinar. If you have questions while watching the webinar, you can type them into the question
field, and a member of the Software Support Team will respond to you within 24 hours. You may also call with
questions during normal business hours.
After the month is over, you can find the webinars in the Visual Help portion of our website.

The 2018 Users Group Meeting is a little over a
month away. Have you registered yet? Join us for the
34th annual Users Group Meeting at the Savannah
Marriott Riverfront in Savannah, Georgia, February
22-24, 2018.
You won’t want to miss the classes, people, and fun!
Register online at www.ortho2.com/ugmregistration.
For more information, contact Kim Barker at
(800) 678-4644 #2 or ugm@ortho2.com.

Contributor Contact Information:

We are excited to announce Ortho2 will
have a Snapchat account for this year’s
UGM! You’ll now get to use your favorite
filters while taking pictures and videos with
your UGM friends. There will even be some
new UGM filters to try out!
Savannah is the perfect place to fill up your
Instagram page with picturesque scenes!
We want to see all the fun you’re having
while attending the UGM. Be sure to use
#O2UGM18 while posting, and don’t forget
to follow Ortho2Systems on Instagram.

#O2ugm18
We want to showcase your pictures! Be sure to use the
hashtag #O2UGM18 when posting your UGM and Savannah
photos for a chance to be featured on our social media TV!

If you are planning a presentation or lecture

Joan Garbo – For more information on

Andrea Cook – Andrea Cook is an

Tina Byrne – For more information on

at a society meeting, university, or local

office consults, executive coaching, or

Orthodontic Clinical Consultant who offers

systems, team building, marketing, and

meeting, we can provide you with any

speaker presentations call (631) 608-2979

a variety of services to train your staff and

custom consulting programs from Byrne

screenshots you need and can discuss how

or write to: Joan Garbo, Joan Garbo

improve your practice. Learn more at www.

Consulting, visit www.byrne-consulting.com

to best use Edge Cloud and/or ViewPoint

Consulting, 19 Glen Lane, Copiague, NY

andreacookconsulting.com or contact

or call (800) 580-6580 or (410) 836-7848.

in any situations you may be illustrating. We

11726. Visit us at www.joangarbo.com or

Andrea at (253) 332-3376 or

appreciate the good word you spread and

email at joangarbo@aol.com.

andrea@andreacookconsulting.com.

would like to assist in any way we can!
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Are you the only person in your office who sees the newsletter? Pass it along!
Use the routing slip on the cover to ensure everyone gets the chance to read
the newsletter.
You can also read the newsletter on our website www.ortho2.com >
Resources > Newsletter.
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Edge Signature
E

dge Signature, a new, free feature

digital signature(s). If you add the document to your

Tasks section > Services drop down > Signature. Or simply

the document is added to the patient’s correspondence

in Edge, provides a way for your

Merge Queue, you will be prompted for these details

right click the document you wish to have signed in the

history.

when you complete the document processing. Once the

Edge Signature Widget and select the signee. Log in using

signers have been selected, the document is added to list

Edge credentials. You must have both an Edge operator

of Edge Signature documents waiting to be signed.

user name and password to use Edge Signature. Once you

mail merge documents to be digitally
signed or initialed by one or more parties
including the patient, responsible party,
orthodontist, professional, operator, and/or
assistant. Use a tablet or smart phone to allow

•

Settings -

users to sign documents right in your office.

(Optional.)

within Edge, you may bookmark this page so you can open
it from your browser.

or initials, you can choose to process all of them in one
session. Open the Multi Sign tab, click Sign beside
your name, and provide your signature. When you
click Continue, the next document will appear for your
signature. Continue until all the documents you need

Adding Signature Fields to Merge
Documents

Enable the

Open the In Progress window to view and sign pending

to sign are processed. If a document requires another

Has Expiration

Edge Signature documents. The list also shows whether a

signature, such as a parent, the document remains in the In

To begin, you will need to add signature or initial merge

option, then

signer has already opened the document, and completed

Progress tab of the Edge Signature service.

fields to either an existing or new merge document. In

enter the date

their signature. Choose the document you want to work

the Mail Merge Documents Editor, open a letter to edit,

the document

with and click Sign. Depending on the type of device you

or create a new one. In Microsoft Word, open the Add-Ins

will expire. If

are using, you may use your finger, a stylus, or another

menu. Choose the Select Fields option to open the Edge

the document

pointing device (such as a mouse) to sign the signature

Merge Field Selector window. Be sure you are viewing the

has not been digitally signed by that date, it will be

pad. If you prefer, you can click Type Signature, then type

Merge Variables tab.

removed from the list of pending Edge Signature

your signature or initials on your keyboard. When finished,

Click the Settings icon on the widget tool panel, then

documents.

click Ok at the bottom of the signature pad.

choose the status of the Edge Signature documents you

Choose the eSign - Initials or eSign - Signature variable
that corresponds to the person that needs to initial or sign

•

the document, and click Insert. Then type a description of
the intended signer, such as patient, parent or guardian, or
doctor. Click Ok to insert the variable into the document.

•

Mail merge documents that support digital initials and/or
signatures include an Edge Signature icon

beside the

name in both the Mail Merge Documents editor and the
Mail Merge feature.

Merging Documents
Initiate your Mail Merge feature, and select an Edge
Signature document. Then choose the recipient, and
select the Sign merge action. Note that if you select any
other Merge Action, you will not be able to digitally sign
the document. You can choose to merge the document
immediately, or add it to your Merge Queue.
If you merge the document immediately, you will be

•

Use the Edge Signature widget to digitally sign documents,
as well as review complete and deleted Edge Signature
documents.

wish to view: Completed, In Progress, or Deleted. You can

the window to identify the people that need to sign

also specify how many documents to show on one page of

and/or initial the document.

your widget.

Choose Signature/Initial to Work With - The left side

The widget shows you the document name, recipient
name, the date the document was first merged, and the

required by the document. The descriptions are the

Save your document.

Edge Signature Widget

Signer Settings - Use the Signer Settings section of

of the window lists all of the Edge Signature fields

You may insert as many initials and signatures as needed.
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Expiration

have opened the Edge Signature Services website from

If you have multiple documents that need your signature

prompts you typed as you inserted Edge Signature

Save your signature. The document appears on your screen

variables into your mail merge document. The Is

again, along with your signature. If you’re satisfied, click

Initials option indicates whether the variable you

Save at the top of the document window. Or, click the

inserted was for initials only.

signature area to open the signature pad again and start

Choose/Skip Signing Party - The list at the right of

over.

the window includes all the people associated with
the patient folder that fit the type of initials/signature
you have selected at the left. You can click to select
the person who should provide the signature/
initials, or select Signature Not Needed to “skip” this
signature/initial location.
Once you save your document, it is added to list of Edge
Signature documents in progress.

prompted to enter an optional expiration date for the

Use Edge Signature Services

document, as well as specify who needs to provide the

You can open this feature from the Home Ribbon Bar >

date signatures were obtained, if any. You also see the
patient’s next appointment, and the document’s expiration
date, if any. The Deleted column indicates whether the
document has been removed from Edge Signature signing
requirements.

If you need to sign the document in multiple places, a list
of the signatures appears at the top of the window. Click a
signature link to view and sign that area of the document.
When you have completed all signatures, the document is

Right click on a document to change the expiration date.

flagged as being completed.

Alternatively, you can right click a document, and start

As soon as you save your signature (or all of the signatures
required from you) you are prompted to close the
document. You are automatically logged out of Edge

the signing process by clicking on a person’s name. A
check mark will appear when that person has signed the
document.

Signature so that the next signer, if any, can log in and
complete their signature. When all signatures are complete,
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Advice on Confronts

SMART Goals

O

A

ne thing that most everyone can

true when we have to deal with someone who is angry or

agree on is that people hate

acting in an upset or hostile way; we immediately get our

confrontation. This is understandable since

A – Achievable

for the New Year. Regardless of how long you’ve

This focuses on how important a goal is to you and

defenses up rather than listen to what they are actually

been in practice, whether 5, 10, 15, or 20+ years, if you

what you can do to make it achievable. It may require

most of us, at some time in our lives, have

saying, or meaning to say. This in turn ends up influencing

are getting the same lackluster results year after year, ask

developing new skills and changing attitudes. The goal is

been confronted by someone, and usually it

how what we say comes across to the other person. Thus,

yourself what needs to change to make this your best year

meant to inspire motivation, not discouragement. Think

was an unpleasant experience. At the same time,

we may say the right words, and yet get the wrong result.

ever.

about how to accomplish the goal and if you have the

In order to be able to come across authentically with the

Moving your office and team to the next level of success

right thing to say, we must first let go of the need to be

is a goal for most offices. Do you get overwhelmed at the

right about our point of view and stay open to listening to

beginning of a project? Do you struggle to boost team

R - Realistic

what the other person is saying. For instance, regarding any

productivity? Do you have a difficult time getting team

Set a realistic goal. Setting an unrealistic goal will make

complaint, the most effective shift you can make is to think

members involved with practice goals? The steps to make

a team member give up before they even try. If team

of this complaint as a gift even though you may not like

this happen are sometimes the missing piece between

members can’t reach the bar it is easier to give up before

the wrapping paper! If you can listen to their conversation

setting goals and achieving them.

they start rather than try and disappoint you.

Setting individual or team goals for your practice can be a

T – Time-Bound

we all know that there are things that we cannot
overlook, and if we do, the problem will get worse.
So, my first piece of advice is DON’T DO IT. That is, don’t
confront people with issues or problems. Rather, confront
issues and problems with people. To enact this, you first
have to eliminate finger pointing and fault finding. Look
first to correct the process or system before you look to the
person as the source of the problem. Asking “what didn’t
work” avoids the blame game and creates a collaborative
approach to problem solving.

from the point of view that it is a contribution to your
commitment to providing excellence in service, you will
naturally create a tone of voice, body posture, and facial

challenge for many offices. Often the goals are too broad

Providing a target date is imperative. Ask specific questions
about the goal deadline and what can be accomplished

them. You may or may not be able to give them exactly

axiom it’s not what you say but how you say it that counts.

what they want, but you will be more apt to create a

The secret to alleviating common project challenges is to

93% of communication is non-verbal. While it is important

cooperative compromise.

set specific goals. SMART goals are designed to provide

language when speaking. Words comprise only 7% of the
message; 38% of the message is auditory (volume, rate
of speech, intonation and inflection, even accent); while
55% of the message is derived from visual aspects (facial
expressions, body language, even what you are wearing
or the environment you are in.) If what you say doesn’t
match up with how you sound or how you look when you

to an agreeable outcome: “I agree...(that this is upsetting);
“I appreciate...(your willingness to tell me...); “I respect...
(your commitment to your child...). These phrases

situation, and was laughing while speaking, you wouldn’t
believe the apology was sincere.
The greater problem is not the external conversation you
have with the person, but rather the internal conversation
you have with yourself about the person or situation. This
little voice in your head can be so loud, that you can’t
hear what the other person is saying. We don’t listen to
understand, but rather we listen to justify. This is especially

identify what you want to accomplish. This method is
especially effective in helping your team set goals that align
with practice goals.

S – Specific

to be avoided are: “it’s not possible...”, using “no” to start

When setting a goal, be specific about what you want to
accomplish. Think about this as the mission statement for
your goal. Goals of simply raising production or reducing

within that time frame. If the goal will take three months
to complete, it’s useful to define what should be achieved
half-way through the process. Providing time constraints
also creates a sense of urgency. Celebrating their success
when goals are met is a huge motivator to continue or
attempt other goals.
Something that’s very important when setting SMART
goals, is formulating it in a POSITIVE manner. Remember
that what you focus on, gets improved.

clinical expenses are too broad. Giving specifics along

speak, the person will think you are, at best, insincere.
For example, if someone was apologizing to you for some

structure and guidance throughout a project, and better

communicate your willingness to listen to them. Phrases

Confronts continued on page 15

Anyone can set goals, but if it lacks realistic expectations
and timing, chances are you’re not going to succeed.

difficult or confronting situations with people is the old

it is even more important to monitor your tone and body

tools/skills, consider what it would take to attain them.

can help you and your team set and achieve goals.

expression that demonstrates real interest and concern for

There are also some phrases that will assist you in coming

tools/skills needed. If you don’t currently possess those

or without a way to measure success. Using SMART goals

Among the most critical aspects in learning to deal with

to remember mom’s admonition to watch what you say,
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s the year 2018 begins we all start to look at goals

About the Author
Joan Garbo is a coach, speaker, and

with the tools and expectations of each team member will
increase involvement from your team.

M – Measurable

About the Author

What metrics are you going to use to determine if you

Andrea Cook is a clinical consultant

consultant specializing in effective

meet the goal? This makes a goal more tangible because it

and trainer for premier orthodontic

communication skills, team building,

provides a way to measure progress. If it’s a project that’s

offices across the country with more

and leadership skills. She will be

going to take a few months to complete, then set some

than 20 years experience chairside.

presenting at the 2018 Users Group

milestones by considering specific tasks or time frames to

She is presenting at the 2018

Meeting in Savannah, Georgia.

accomplish.

Users Group Meeting in Savannah,
Georgia.
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What’s in Your Toolbox?
P

rior to discussing consulting

•

services with a doctor, I perform a

complimentary remote evaluation of their
systems and productivity. Why you ask?

Create a subgroup with the following parameters:

•

report.

•

Appointment Date – Prompt

•

Appointment Next Procedure = procedures to be

Task: Review insurance accounts of patients in the event

reviewed

information or discussion is needed

Frankly because I prefer a win-win working
relationship, and moreover to gain insight into

In ViewPoint, run the Appointment Day Sheet - Financial

Dock a Subgroup Widget on the Dashboard, select the

•

fields below to be visible, and review the patients in

the depth of configuration and utilization of the

the list

practice management software (PMS) program. PMS
is the most important tool for an orthodontic office. In
addition to patient management, it’s a means to establish

•

efficiency, maintain productivity, and measure the success

approximately 25% of their PMS resources, are unaware of

what’s in their toolbox!

•

•

Appointment Next Procedure = procedures to be

organizing team members for task preparation and patient
•
The Dashboard is user-defined and can be loaded with

•

•

Contract Balance >0

Print the Open Insurance report with that subgroup to

View the list by clicking Actions > Subgroup List and
choose your subgroup from the list

Appointment Next Date – Prompt

•

Appointment Next Procedure = procedures to be
reviewed

•

•
•

Appointment Date – Prompt

settings to change the date

•

Patient Status = all active treatment statuses

•

Treatment Expected Removal <= Today

In ViewPoint:
•

Create a subgroup with the following parameters:

discussion

•

Insurance = Yes

•

Balance – Greater than – 0

numerous reports, the reports can be placed into a
folder and generated all at once.
•

Create a subgroup with the following parameters:
•

Appointment Date – Prompt

•

Contract is Insurance = No

•

Days Past Due >= 30

Dock a Subgroup Widget on the Dashboard, select the
fields below to be visible, and review the patients in

for patients on the schedule and the manner in which

the list

they can become more efficient with the program. These

•

Clinical Team
Task: Check of appliances to be delivered for the day and
that the appliances are ready
•

Create a subgroup with the following parameters:
Appointment Date – Prompt

in each scenario.

•

Appointment Next Procedure = procedures to be
reviewed

Financial Coordinator
wrench icon to view the desired day

Dock a Subgroup Widget on the Dashboard, select the
fields below to be visible, and review the patients in
the list

choose the subgroup you created

•

Each day, simply change the date by clicking the

•

Run the Insurance Detail By Company report and

numbers can also be pulled in ViewPoint, which we address

•

Create a subgroup with the following parameters:
•

Appointment Next Date – Prompt

frequently. If team members are responsible for

View the list by clicking Actions > Subgroup List and

Each day right click on your quick report, select edit

•

Quick Reports allow users to save reports they use

contracts are in place and forms are prepared for signature

•

time or nearing treatment time

Task: Identify patients with overdue accounts for financial

•

Task: Review patients beginning treatment to be certain

Create a subgroup with the following parameters:

Task: Review of patients on the schedule over treatment

define the fields you want to view for the patients.

Let’s look at what is typically the team’s daily preparation

Contract is Insurance = Yes

choose your subgroup from the list

reviewed

follow-up.

3.

•

Create a subgroup with the following parameters:

and Quick Reports have become my go to functions in

Subgroup Widgets allow you to load a subgroup and

In ViewPoint:

In ViewPoint:

Appointment Next Date – Prompt

2.

Appointment Date – Prompt

wrench icon to view the desired day

•

widgets specific to each team members’ tasks.

•

Each day, simply change the date by clicking the

In Edge Cloud, the Dashboard, Subgroup Widget,

1.

wrench icon to view the desired day

Create a subgroup with the following parameters:

to Quick Reports
•

the functions, and/or are uneducated on the system. They
don’t know what they don’t know AND they don’t know

Each day, simply change the date by clicking the

review for any problems with insurance account. Save it

in all areas of a practice!
The majority of offices I visit for the first time are using

•

•

Toolbox continued on page 15

About the Author
Tina Byrne’s leadership qualities and
upbeat presentation style provide
a fresh perspective on the many
challenges faced daily by the entire
orthodontic team. Tina is presenting

Dock a Subgroup Widget on the Dashboard, select the

at the 2018 Users Group Meeting in

fields below to be visible, and review the patients in

Savannah, Georgia.

the list
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Inside Ortho2
Information about the people of Ortho2 and the resources available to you as a member

Free Webinars

Ortho2 Anniversaries

We offer you free, online webinars each month throughout the year on various topics. It’s a great solution for training new

Congratulations to these Ortho2 staff members who celebrated anniversaries during the fourth quarter of 2017.

users, refreshing experienced users, or learning about new features. Webinars are available online at www.ortho2.com >
Meetings and Webinars > Ortho2 Webinars. Find the topic for the month and click the link to view the webinar at your
convenience.

Upcoming Webinar Topics
January – ViewPoint: Grid Bar Close-up

Twenty-Five Years

Nineteen Years

Twelve Years

Todd Schuelka

Lowell Davis

Derek Dohrman

Twenty-Three Years

Jennifer Shaffer

Denise Sargent
Michele Eich

February – Edge Cloud: Common Subgroups for

Brian Good

Thirteen Years

Scheduled Edge Reminders

The Grid Bar serves as a clipboard for appointments

Five Years

Corey Schmidt

Four Years

waiting to be rescheduled, as well as a notification board

Sending reminders with Edge Reminders is simple

for patients on your Needs Appointment and Sooner if

when using the correct subgroups. In this webinar we

Possible lists. You can also use the grid bar to record notes

will demonstrate setting up common subgroups for

about a specific date on your schedule, and optionally view

appointments, missed appointments, recalls, and birthdays.

appointments from your Office Calendar and HR Manager

With these in place, your set up process will be a snap!

Retraining

March – ViewPoint: Word Merge Basics

Have you hired new staff since your original software training? Have you had staff members take on new responsibilities?

Calendar. In this webinar, we’ll take a close look at each
section of the Grid Bar and explain how appointments get
placed to each section.

Did you know you can customize the letters in your letter

Steve Volcko

Do you feel you might not be taking advantage of the enhancements that have been added over the years?

library so that each letter is personalized to your patients?

Ortho2 offers many options for refreshing your knowledge of old features and informing you of new features, but do you

This webinar will demonstrate how to create new and edit

want to be able to set your own agenda to meet the specific needs of your practice?

current letters. In addition, we’ll review basic formatting,
variables, and other merge tools.

Career Milestones and Development
Todd Schuelka celebrated his 25th Ortho2 anniversary on November 23. The celebration included chips, salsa, his favorite
beer and stories from the past. Did you know Todd earned the nickname Phantom of Ortho2 for being at the office after
hours so many times? Congratulations on this accomplishment, Todd!

A retraining — either in your office or over the Internet — addresses all these issues. To learn more and to schedule one
for your practice, contact your Ortho2 Regional Manager today at (800) 648-4644 or sales@ortho2.com.

Our Feedback Forum
Ortho2 brings you UserVoice, a powerful feedback forum that allows you to easily tell us what you think! Now you have
the power to connect with us, make suggestions for enhancements, vote on your favorite ideas, and watch them become
a reality.
Log into UserVoice through the Ortho2 website. Visit www.ortho2.com, and click the UserVoice icon

in the upper right

corner. Login with your user name and password. You are ready to go!
There are five product enhancement forums: Edge Cloud, Edge Animations, Edge Imaging, Ortho2 Users Group Meeting,
and ViewPoint. You can search existing suggestions and enter your own. Vote for your top enhancements and check back
to see which are getting the most votes. You can even add comments to suggestions and read comments from other users
and from Ortho2.

Celebrating Todd’s
25th Anniversary
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Chat Support

Holidays

Do you need to call into our Support Team for a question, but it’s difficult to wait on hold, even for a few minutes? Ortho2

Our corporate office is closed on the following holidays:

has you covered! Use our chat support to get in contact with us. When you use the chat support feature, you will be
added to the same queue as phone calls. You can choose to chat with the Software Support, New Customer Care, or
Network Engineering Teams.
In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint version 11, it is the bottom right
Help button in the Daily Activities menu.
So drop us a line when you are in a pinch! We are here to help you in whatever way is most convenient for you.

Help Us Help You
Please be prepared to provide your customer number, practice name, and office location when you call our support teams
for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you use ViewPoint, you will
find your customer number by clicking the Help menu and choosing About. Please be sure to provide this information—

New Year’s Day

Independence Day

Thanksgiving Day

Memorial Day

Labor Day

Christmas Day

If a holiday falls on a Saturday, we observe the holiday on the prior Friday. If a holiday falls on a Sunday, we observe the
holiday on the following Monday.
The Friday after Thanksgiving, Christmas Eve, and New Year’s Eve are optional holidays. We offer limited support on those
days.

Log into the Customer Site of Ortho2.com
There are many resources available to you on our website. You will find visual help files, printed documentation, FAQs,
information on upcoming meetings, the ability to register for webinars, and more.

and repeat your phone number—when leaving a phone message requesting support. Having clear information helps us

If you haven’t already created an account to access the Customer Site of our website, you will need to do that. Each

serve you more quickly.

doctor and staff member can create their own account. Visit www.ortho2.com, and click the feature you want to see, such
as Edge Cloud videos or ViewPoint documentation.
Next, click the Register a New User Account link on the login screen. You will be prompted for your full name, main office

Support

phone number, and Ortho2 customer number. Finally, enter your individual email address, a password of your choice (at

By Phone: (800) 346-4504

And Don’t Forget Our Website: www.ortho2.com

Available 7:00 A.M. – 7:00 P.M. Central

Our website gives you 24/7 access to our knowledge base, FAQs, white

Time, Monday – Friday

papers, visual help videos, and more.

By E-mail: ortho2support@ortho2.com

least five characters), and a display name that will be publicly visible.

Contact Us
Phone

Email

Social Media

Response time is usually the same day or

(800) 678-4644 (Sales)

admin@ortho2.com

www.facebook.com/ortho2

at most within 24 hours.

(800) 346-4504 (Support)

engineering@ortho2.com

www.youtube.com/ortho2systems

ideas@ortho2.com

www.twitter.com/ortho2systems

orders@ortho2.com

www.linkedin.com/company/ortho2

ortho2support@ortho2.com

www.instagram.com/ortho2systems

sales@ortho2.com

https://plus.google.com/+ortho2

ugm@ortho2.com

http://blog.ortho2.com

Website
www.ortho2.com

Newsletter Submissions

www.ortho2.uservoice.com

editor@ortho2.com

Background image taken by Lori Backous
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Confronts continued from page 6

Referral Rewards

the response; using “but” after saying you understand. In

To summarize, don’t confront people with issues, confront

regards to the word “but”, you will notice that whatever

issues with people; look first to correct systems or

follows the “but” negates what precedes it. For example, if

processes before people; be authentic in your speaking;

you were to say “I really like you but I disagree with you,”

and speak to others in a way that shows respect and

the other person will not remember that you like them.

maintains their dignity.

However, if you were to say “I really like you and I disagree

You can earn a $500 credit for each referral that results in an Ortho2 system purchase within six months. You can apply the

with you,” your relationship with that person stays intact.

credit toward any current or future charge or purchase—it never expires. We frequently hear from doctors that they wish
we had contacted them before they purchased their current system. We wish we had too, but we didn’t know they were
looking. You can help us help your colleagues by letting us know when they are considering a change in systems. Enter
referrals online at www.ortho2.com and clicking on the Referral Rewards icon

in the top right corner, or call

Toolbox continued from page 9
•

(800) 678-4644.

Each day, simply change the date by clicking the

Treatment or Marketing Coordinator

wrench icon to view the desired day

Task: Report New Patient Calls and Referral Sources

In ViewPoint:

Service Excellence

•

We invite you to recognize Ortho2 employees by sending Extra Mile cards. A card is included in this newsletter, or you
may send cards online from the Contact Us page of our website. Our goal is to uphold our tradition of excellence in
customer service, and with our Extra Mile program, you can let our employees know when you appreciate their extra

•

to serve you. Thank you for helping us recognize excellence.

Create a subgroup with the following parameters:
•

Appointment Next Date – Prompt

•

Status = all active treatment statuses

•

•

Appointment Date – Prompt

•

Appointment Status = Kept

•

Appointment Last Kept Procedure = all start

•

Dock a Subgroup Widget on the Dashboard, select the
fields below to be visible, and review the patients in

•

Patient Entry Date <= Prompt

Dock a Subgroup Widget on the Dashboard, select the

Each day, simply change the date(s) by clicking the
wrench icon to view the desired day(s)

In ViewPoint
•

the list

Create a subgroup with the following parameters:
•

•

and we would encourage them to sign up as well.

Entry date – Range of dates - Prompt

Run either the Patient Biographical report or Subgroup
List depending on what you plan to do with the
patient.

To register email addresses for this program, simply visit the Register for Updates section of our website,
www.ortho2.com > Resources > Register for Updates. As mentioned above, multiple individuals from your office can

These are only a few examples of the set up for several

register. Even if we already have your email address, it won’t hurt to register here, and it will guarantee your inclusion in

daily tasks utilizing only three functions of Edge Cloud. The
•

Each day, simply change the date by clicking the
wrench icon to view the desired day

And of course, if you or any of your staff ever decide that the messages are not of interest, you can simply use the opt-out

In ViewPoint:
•

•
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•

Create a subgroup with the following parameters:

Furthermore, we believe associate doctors and members of your staff will benefit from the productivity and usage tips,

option provided on each message.

Patient Entry Date >= Prompt

the list

procedures

these messages.

this program.

•

fields below to be visible, and review the patients in

Run the Exceeds Length of Treatment report and

Here’s an exciting opportunity to enhance your success with Ortho2 products and services and be among the first to get
features, productivity tips, meeting updates, periodic optional feedback surveys, and more. We think you will like getting

Create a subgroup with the following parameters:

Task: Care Calls to Previous Days Start Procedures

Join Our Email List
news. We have an email communication program which includes money saving discounts and incentives, overviews of new

•

choose the subgroup you created

effort. We encourage you to send an Extra Mile card whenever an Ortho2 employee goes the extra mile for you. The
recognition is valued by the recipient and is acknowledged by our management team. We continue to look for better ways

•

Create a subgroup with the following parameters:
•

Last kept date – Prompt

•

Last kept procedure = all start procedures

possibilities are endless!
If your team is unaware of all the functions your program
offers, I encourage you to take advantage of the online
training materials at www.ortho2.com > Support and
Learning > Visual Help . Don’t hesitate to contact
Ortho2 support for assistance with configuration of your
subgroups, and if you want to take your practice to the

View the list by clicking Actions > Subgroup List and

next level with your program – attend the Ortho2 Users

choose your subgroup from the list

Group Meeting. You won’t be disappointed.
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“Delivering premium solutions for success to the orthodontic profession…”

Dealing with conflict is a difficult task for

Edge Cloud offers many tools to organize your team for

some. How you say things and your body

patient follow up. See how the Dashboard, Subgroup

language play an important part in working

Widget, and Quick Reports can make your day easier.

through conflicts.

page 8

page 6

Ensuring your business makes it to the next
level of success doesn’t just happen by
chance. Setting SMART goals paves the way
for you.
page 7

ORTHO2
Sales (800) 678-4644

Support (800) 346-4504

Local/Intl. (515) 233-1026

Fax (515) 233-1454

